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This file documents the list of new features, enhancements, and “adjusted anomalies”, 
starting with the most recent Rel 2.11, followed by the 2.10.x, 2.9.x, 2.8.x (see end of 
document for earlier releases).  Each page’s header shows the version for that current 
page. 

1. New Hardware (these require Do-more Technology Version 2.11) 

BX-P-OPCUA 

BRX PLC Pluggable Option Module: OPC Unified Architecture (UA) Server 

Communications Module (1.03) 

• Define up to 500 Data Points of elements in the BRX PLC using the Element 

Documentation Editor 

• Service up to 5 Client sessions with up to 5 Subscriptions per session 

simultaneously via OPC UA TCP 

• Supports multiple security options (see 2. below) 

BX-P-SPARK 

BRX PLC Pluggable Option Module: Sparkplug B Edge Node Communications 

Module 

• Define up to 300 Tags of elements in the BRX PLC using the Element 

Documentation Editor 

• Supports multiple MQTT Broker security options (see 3. below) 

BX-P-USB-C BRX PLC Pluggable Option Module: USB C Programming port 

BX-16TDY2 BRX 16 point 24VDC 1A Discrete Output Expansion Module 

BX-16TD2W 
BRX 16 point Diagnostic Discrete Output Expansion Module 

detects overload, short circuits and wire breaks 

BX-16NN BRX 16 point 48VDC Discrete Input Expansion Module 

BX-16TN2 BRX 16 point 48VDC Sourcing Discrete Output Expansion Module 1A 

BX-8NN8TN2 BRX 16 point 48VDC Discrete Combo Expansion Module, 8 pt. In, 8 pt. Sourcing Out 
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2. IIOT - OPC Unified Architecture Server (BRX Only) (requires Do-more Technology Version 2.11) 

Make your BRX PLC be an OPC UA Server by adding the BX-P-OPCUA to the POM slot. 

a. Configure BX-P-OPCUA POM 

From the PLC->System 

Configuration dialog’s 

CPU entry page, hit 

[Setup POM] button, select 

BX-P-OPCUA tab to 

configure the PLC’s 

OPC UA Server. Configure 

the various security settings 

based on your Network and 

Clients’ security needs. 
 

b. Map Specific BRX Elements as OPC UA Data Points 

From the Element Documentation Editor, select the set of BRX Elements that will be available 

to any OPC UA Client as Data Points.  Everything is DISABLED by default. 

 

c. Monitor the Live Status of the OPC UA Client POM 

Select Debug->OPC UA Monitor menu to 

launch the monitor dialog.  The table lists out 

the System DST Elements, Descriptions, 

and the current Status values. 

All of these System DST values are available 

to your PLC logic or HMI. (see the Element 

column for the specific DST IDs along with 

any specific casts).  One of the DST’s 

contains Control Bits for Inhibiting 

Communications and Resetting Error Codes. 
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3. IIOT - Sparkplug B Edge Node (BRX Only) (requires Do-more Technology Version 2.11) 

Make your BRX PLC become a Sparkplug B Edge Node Client by adding the BX-P-SPARK to the 

POM slot. 

a. Configure BX-P-SPARK POM 

From the PLC->System 

Configuration dialog’s 

CPU entry page, hit the 

[Setup POM] button, 

select the BX-P-SPARK 

tab to configure the 

connection to your 

Sparkplug B MQTT 

Server. 

 

b. Map Specific BRX Elements as Sparkplug B Tags 

From the Element Documentation Editor, select the set of BRX Elements that will be available 

to your Sparkplug B MQTT Server.  Everything is DISABLED by default. 

 

c. Monitor the Live Status of the Sparkplug B POM 

Select Debug->Sparkplug B Monitor menu 

to launch the monitor dialog.  The table lists 

out the System DST Elements, Descriptions, 

and the current Status values. 

All of these System DST values are available 

to your PLC logic or HMI. (see the Element 

column for the specific DST IDs along with 

any specific casts).  One of the DST’s 

contains Control Bits for Inhibiting 

Communications and Resetting Error Codes. 
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4. New Instructions (DmT 2.11) 

a. ENCRYPT – Encrypt Message and DECRYPT – Decrypt Message (BRX and Simulator) 

Utilize the Ascon-128 Cipher encryption algorithm to the BYTEs of a data buffer or to a string 

using your predefined Private Key and current Nonce as inputs.  This can be useful in certain 

applications for enhanced custom protocol security or encrypting data file content. 

 

 

5. Enhanced C-more Tag Export Dialog 

Filter in/out Used Elements, 

Nicknamed Elements, System 

Nicknames, or any combination 

(6+ filter groups) based on the 

selected C-more driver (Built-Ins 

vs. Symbolic). 

Utilize the implied auto-generated 

Tag, or enter or generate C-more 

tags (up to 128 characters) based 

on other pieces of Element 

Documentation (Extra Info, 

Description), not just the 

Nickname. 

  

C-more tags are no longer limited to certain Alpha-Numeric characters or length.  Enter 

spaces, symbols, punctuation, whatever: Machine #XYZZY-123 SL_ABC, up to 128 

characters.  Easily add any elements to the Tag list that aren’t specifically referenced in your 

program, like all the fields of an entire Range of a UDT Recipe data-block that is only referenced as 

an array. 
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Perform Bulk Edits / Bulk Generation of the C-more 

tags.  For example, prepend a Machine ID to some or all 

of your Tags OR generate the text for a bunch of Tags 

based on Element Description field, but just for the 

Elements that have “HMI” in the Extra Info field, etc. 

 

6. Features 

a. Ladder View – Ladder Box Background Color by Box Class 

Each Box Class group has its own predefined pastel background color to help distinguish the 

set of boxes in that class. 

  
Change the colors or turn it off by right clicking on the Ladder Toolbox or in the Ladder View 

Options’ Display tab (Miscellaneous group box). 

b. Help->Keyboard Shortcuts dialog 

Lists out of ALL hot key shortcuts 

and what they do across ALL the 

various Views/Contexts. 

The list is sortable by any of the 

columns, making it easy to 

discover what is available. 

The dialog resizable and is 

modeless, meaning it can stay 

open while you work inside the 

related View or Context. 
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c. Create Windows Shortcuts to your favorite Designer .DMD Project Files or 

Communication Links 

Easily launch Designer with your favorite Projects or PLC Links just by double clicking a 

shortcut on your Desktop.  To create a Windows Shortcut, use the File menu 

File->Create Windows Shortcut->To this Project File or ->To this Communication Link 

d. Ladder View – Assign Keyboard Accelerator Hot Keys to your Favorite Instructions 

Assign Ctrl+1 through Ctrl+0 as hot keys to your 

favorite instructions for editing. 

Right Click in the Ladder Toolbox and select 

Assign Instruction Hot Keys to configure your 

favorites. 

Your specifically assigned hot keys will show up in 

the Ladder Toolbox tooltip for their corresponding 

instruction, and show up in the new Keyboard 

Shortcuts dialog mentioned above. 

This is actually an oldie but a goodie, but was 

never documented here.  If you’ve been using it, 

great!  If not, and you prefer programming with a 

keyboard, try it out – your fingers will thank you. 

 

e. Ladder View – Instruction Tools  

i. View/Modify Memory Image Region Data 

Utilized by instructions that have block/range of data as an Input parameter, where that 

block has a Memory Image Region defined.  Launch the Modify Memory Image Region Data 

tool by floating the mouse cursor over the instruction’s Wrench icon and selecting that tool 

for the specific block parameter. (6989) 

ii. Tools Menu Utilizes Vertical Spacing to Group Related Tools (6894) 

f. Ladder View – Status 

i. BYTE Buffer Ladder Status 

Shows the status of the first 6 BYTEs in hexadecimal 

format of any BYTE buffer parameter. 

Supported instructions: STREAMIN, STREAMOUT, 

PACKETIN, PACKETOUT, FILEREAD, FILEWRITE, 

HTTPCMD, ENCRYPT, DECRYPT.  

ii. SLOPE – Pop-up Tool to Monitor in Trend View 

Trace the Input and the resulting Slope parameter values in different panes. 
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g. Ladder View – Enhanced Mouse/Keyboard Ladder Editing (6891) 

With focus on a specific Parameter in the Ladder display (block cursor on instruction and 

parameter focus rectangle on a specific parameter), hitting the SPACEBAR in Ladder Edit 

mode will launch that instruction’s editor, with focus placed on that Parameter’s Edit Field. 

 

Similarly, DOUBLE-CLICKING on a specific Parameter in the display will launch that 

instruction’s editor, with focus placed on that Parameter’s Edit Field. 

 

These behaviors can be changed in the Ladder View Option’s dialog, Edit tab.  The SPACEBAR 

behavior is ON by default.  The DOUBLE CLICK behavior is OFF by default. 

h. Ladder View – COPY Instruction 

i. Added [Swap Source & Destination] button 

Could be helpful when copying a large set of elements at the top of scan, then need to do 

the opposite at the bottom of scan. (6832, thanks to RP) 

ii. Added [Insert Structure Fields] button 

Generates the individual table row entries for the 

fields of the specified Source and/or Destination 

structures (2765). 

 

i. Ladder View – CALL Instruction Added [Copy/Swap Input Table] Button to Output Table 

Useful for when the Input Parameter Table has a set of Input parameters to the Subroutine 

CALL, and the Output set of parameters is just the “swap” of the Input Parameter Table (6907). 

j. Ladder View – PWMOUT – Pulse Width Modulation Output Instruction Editor 

Added PWM Structure members .PeriodScale 

selection bit and .Period value based on the 

entered Frequency (Hz) value.  The editor 

translates the Hz Frequency value to a 

milliseconds or microsecond Period value. 

This shows the behavior of the PWMOUT 

instruction in that all it does is set those two 

PWM Structure members (which can also be 

done via simple SET/RST, MOVE instructions) 

 

k. File->Project Options 

Nickname/element mapping is written to the PLC to enhance the Symbolic Communications 

Driver (it supports Nicknames too, not just elements).  This list can be large.  Added option to 

EXCLUDE Nicknames to reduce the time to write the project to the PLC.  However, the 

REST API, the BRX OPCUA and Sparkplug B POMs, can all be greatly affected by this option.  

See new Program Check rule W83 below. 
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l. File->Import->Memory Data, Memory View Import, Memory Image Manager Import 

Properly supports CSV data files with Structures and field values; expected file format is 

consistent with the Memory View Export format; File-Import->Memory Data also supports 

entries for DIFFERENT blocks and heap items that all have the SAME SCHEMA 

 

For example, MyUDT structure schema based blocks MyBlock0, MyBlock1, MyHeapA, 

MyHeapB can be entries in the same CSV import file because they are all MyUDT schemas – 

which is specified in the TOP line of the CSV file followed by all of the data field rows (6868). 

m. Dashboard View 

i. In the local base display, floating the mouse over one of the BRX Ethernet POMs shows a 

tooltip with detailed Ethernet TCP/IP Addressing information (6903), and links to any 

applicable Monitor tool (6917). 

ii. In the local base display, clicking on most of the BRX POMs will pop up a menu with 

helpful tools applicable to that specific POM.  If the POM has an associated device system 

heap-item, one menu item will monitor the heap-item status in a Data View.  If it’s one of 

the new BRX Protocol POMs, another menu item can launch the specific Protocol POM’s 

Debug Monitor.  Added menu item to launch NetEdit 3 for the POMs which need NetEdit 3 

to update their firmware (ECOMLT, SPARK, or OPCUA, 6291). 

iii. In the Communications Pane, when online and where applicable, added Monitor I/O 

Masters/Scanners menu for quick launch of the Ethernet I/O Comm Monitor, EtherNet/IP 

Comm Monitor, and Modbus I/O Scanner Monitor. 

iv. In the Communications Pane, when online and where applicable, added Monitor 

Protocols menu for quick launch of the OPC UA POM Monitor, Sparkplug B POM Monitor, 

and Do-more Logger application. 

v. added more ways to launch NetEdit 3, which is needed in order to update firmware for 

certain BRX POMs.  Just click on the  

n. System Configuration – Setup POM Dialog 

When Online to a PLC, the Setup BRX POM dialog defaults to the currently installed POM (if 

one is currently plugged in) (6901). 

o. I/O System View – Refresh Ethernet Bases’ Status Button  

The Ethernet I/O Bases’ Status reads are 

actually done in the background by the 

PLC, not directly by Designer.  When 

requested by Designer, the PLC then 

requests the status of up to 16 Bases as 

part of its Ethernet I/O cycle. 

Hence, the high-level request by Designer 

to Read Bases’ Status in the I/O System 

View is now done explicitly/foreground via 

the new Refresh button on its toolbar, next 

to the Status ON/OFF sticky button.  
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p. Project Browser – Control Logic Tree 

Added Open Debug View to those tree items’ right click context menu. 

q. Arrange Windows Dialog 

Easily Tile, Cascade. Minimize, Close, 

Activate any set of primary MDI Child 

Windows (6840). 

Tiling Vertically is great when needing to 

read or do status on multiple Ladder 

Code Blocks side-by-side. 

Tiling Horizontally is great when needing 

to synchronize the timelines of multiple 

PID and/or Trend Views status traces. 

(see Windows->Arrange Windows… menu)  

r. Data View – Copy Status to Clipboard added to right-click context menu (6918); Ctrl+V Paste 

supported within Edit column’s text editors (6919) (thanks to GD). 

s. Memory View – Added support for BINARY format display/editing for Integer Data Blocks 

(6896); when going offline, views remain open and disk project workspace maintains their 

window layout when re-opening disk project, regardless of PLC connection (6493). 

t. EtherNet/IP Scanner – Added 19 new Adapter products from 9 different vendors to the 

Electronic Data Sheet (EDS) Profile library (new RFID, Cameras, Sensors, I/O Link, PLCs, 

Drives, Soft Starters, …).  Hit the Add Adapter with EDS button in the System Configuration’s 

EtherNet/IP Scanner page to see the hierarchy of pre-installed and imported Adapters (you can 

always import your favorite 3rd party products’ EDS files to the library). 

u. Enhanced Implicit Extra Info Text for I/O 

By default, Discrete and Analog I/O show the Master/Base/Slot and Point/Channel number in 

the Extra Info field when the user has not entered any Extra Info documentation for that specific 

X, Y, WX, WY, RX, RY element. 

The Extra Info text now includes Analog Scaling and High Speed I/O configuration information 

via a character value replacing the normal space character between the Master and Slot (5688): 

WX/WY * when scaled (WY1: Local*S0:oCH2) 

RX/RY * when scaled (RY1: Local*S0:oCH2), ? when not scaled (RY0: Local?S0:oCH1)  

X: c High Speed Counter (X0: LocalcS0:iPT0), t Timer (X4: LocaltS0:iPT4), p Pulse Catch 

(X5:LocalpS0:iPT5), m Multiple (X1: LocalmS0:iPT1) 

Y: A Axis (Y0: LocalAS0:oPT0), P Pulse Width Modulation (Y2: LocalPS0:oPT2), T Table Driven 

Output (programmable limit switch, Y3: LocalTS0:oPT3) 
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v. New System Status Nicknames 

DST80 

DST81 

DST82 

DST83 

DST84 

DST85 

DST86 

DST87 

DST88 

DST89 

$POMProtoInfo0 

$POMProtoInfo1 

$POMProtoInfo2 

$POMProtoInfo3 

$POMProtoInfo4 

$POMProtoInfo5 

$POMProtoInfo5 

$POMProtoInfo7 

$POMProtoInfo8 

$POMProtoInfo9 

POM Protocol Information and Control Registers that are 

specific to each Communication POM Protocol module, like 

BX-P-SPARK and BX-P-OPCUA. 

For specific details of these DST registers based on the 

specific Protocol POM, see Help Topic DMD0547 Protocol 

POM Monitors. 

w. New Program Check Rules 

i. M87 UDP Device w/o PACKETIN instruction (possible packet buffer resource issue) 

The low-level Ethernet port has a fixed number of incoming pending packet buffers for all 

ports/services.  These buffers are expected to be processed by the PLC firmware for each 

specific port/service.  If an Ethernet packet shows up on your network on a specific UDP 

port that matches the PLC’s UDP Connection UDP Port number, targeting the PLC’s IP 

Address or is (worse) a broadcast packet, but without a PACKETIN instruction to process 

it, these buffer resources will be utilized but never freed, eventually affecting all incoming 

Ethernet traffic.  Double-clicking on this rule provides some helpful diagnostics when online 

to the PLC (6858). 

ii. W86 Installed ECOMEX POM Gateway Address conflicts with On-Board Gateway 

Address (6914). 

iii. W85 Installed ECOMEX IP Address is on same Subnet as On-Board IP Address (6915). 

iv. W84 Installed POM Missing Configuration 

v. W83 Nickname table not populated in PLC; service cannot lookup Nicknames 

will be issued when you have the File->Project Options to EXCLUDE Nickname support for 

the Symbolic Driver, but also have one of these services enabled or configured: 

REST API, Protocol POM (BX-P-OPCUA or BX-P-SPARK). 

7. Adjusted Anomalies 

a. Ladder View - better error messages when doing status on STRINGs; does not do status on 

hidden temporary string, bits, and numeric parameters; Instruction Tools (wrench) Memory View 

should not show up offline (6894); widened RAMPSOAK instruction when Status is ON to 

eliminate ellipsis on clipped status text (6890); COPY/CALL instruction editors provide better 

detail in their error messages (6905); Common Timer editor no longer affects display of actual 

Timer instructions (6923); Common Timer editor displays proper timing diagram for the 

TMRADOWN timer option (6931); Rung Comment Editor properly handles non-Medium default 

text size (6929); 
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b. System Configuration – EtherNet/IP Scanner Adapter’s EDS File Processing added modal 

Operation Status Dialog for better handling when reading large EDS files; Implied Adapter 

Assembly Length in EDS file is properly handled; Expanded EtherNet/IP Scanner Generic 

Adapter’s I/O maximum assembly size from 400 to 504 BYTEs; Setup POM dialog [Help] button 

or F1 (Help) key launches the Help topic for the currently selected POM; 

c. Trend/PID View - widened Period slider on toolbar so detents are more obvious (6889, thanks 

to KH); 

d. File->Import->Memory Data, Memory View Import, Memory Image Manager Import – 

properly IMPORTs CSV double double-quote escape sequences for STRING elements and 

structure fields; this CSV format has always been done by Designer’s Data Export facilities, as 

required by Excel and other CSV import mechanisms (6902); 

e. Cross Reference View – ranged entries refresh on a Block Name change (6875); 

f. EtherNet/IP Scanner Monitor Dialog – properly close when disconnecting from the PLC 

(6877). 

g. Offline Setup – changing from Simulator to 205 works properly (6749, 6911); properly sets the 

project’s Modified (Write to Disk) state (6925) 

h. Output Window – maintains floating position after performing Save to Disk (6722). 

i. Window->Default Layout – restores floating windows to same window as application. 

j. I/O System View – stabilize background communications (Read I/O Configuration, 6829). 

k. PID Overview View – context menu properly supports all the secondary PID instruction Cross 

Reference links (RAMPSOAK, ALRATE, ALDEV, SCALE, 6878) 

l. Modbus I/O Scanner – adjusted terminology for consistency throughout various dialog boxes: 

high level function is Modbus I/O Scanner, the Modbus slave devices it controls are Modbus 

Scanner I/O Devices; added new version of the Socomec Power Monitor profile 

(Socomec Diris V1_2.mdp) that properly performs WORD SWAP on the various 32 bit signed 

integer Modbus Holding Register parameters (thanks to GSK). 

m. Memory Image Manager – when connecting to a PLC with a disk project with Memory Image 

Regions, provide better options on how to synchronize data in the PLC with data on disk; 

re-labeled Memory Image Manager Modify Region Data button to Modify/View/Import/Export 

Region Data (6608, 6692 thanks to MF). 

n. IP Settings Dialog and SETUPIP Instruction Editor – warn when Subnet Mask is invalid; 

warn when Gateway IP Address does not fall on PLC’s configured IP Address’s subnet (6924). 

o. Project Browser – do not allow editing of rung comments unless in Edit Mode. 

p. File->Write to Project to PLC – Nicknames stored for the Symbolic Driver maintain case. 

q. Communication Server – at launch of Designer, properly display Communication Server error 

dialog for bad Communication Links whose Communication device is now missing from the PC 

(e.g. COM9 USB to Serial cable that is no longer connected to the PC); better handling of 

unstable VPN connection or USB to Ethernet Adapter removal since these situations can cause 

the PC’s Ethernet Adapter device to disappear, also offer to Disconnect/(Re)Connect if the 

PLC->Re-open Session fails (5875, 6926, thanks to GD). 
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1. EtherNet/IP Implicit Scanner 

(requires Do-more Technology Version 2.10, BRX and Simulator only) 

Finishing out the EtherNet/IP set of Explicit and Implicit messaging support, BRX Do-more PLCs 

are now capable of performing Implicit Scanner to up to 32 I/O Adapter devices.  Import the 3rd 

party vendor’s .EDS file and choose from their various Connections to map their T->O and O->T 

packet contents to Do-more Memory, along with entering any required Configuration parameters. 

You can even create an EDS Assembly-Specific User Data Type and map the Assembly’s 

named parameters to your named structure fields.  Create that specific Device’s Assembly as a 

single Heap-Item, or even create a block of the UDTs when you have multiple instances of the 

same EtherNet/IP device to leverage array referencing.  Your Do-more UDT data will automagically 

be updated by the EtherNet/IP Adapter’s specific T->O and O->T I/O cycles. 

From the PLC->System Configuration dialog, just select the EtherNet/IP Scanner option below the 

I/O Configuration Entry, and check the Enable EtherNet/IP Scanner Service to get started. 

 

You can also access the EtherNet/IP Scanner configuration via the Dashboard’s I/O Panel in the top 

right. 
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a. Find EtherNet/IP Adapters (“NetEdit” functionality for EtherNet/IP Adapters) 

Just hit the Find Adapters… button on the EtherNet/IP Scanner page of the System 

Configuration to have your PLC query its network for any existing EtherNet/IP Adapter 

devices.  Pick and choose any of the devices to add them to your Scanner.  Utilize their EDS file 

if it already exists in Designer’s Profile Repository, or Import any third party EDS files into the 

repository.  EDS files greatly help with configuring that specific Adapter. 

 

b. EtherNet/IP Scanner Monitor 

When online, monitor the 

status of all your EtherNet/IP 

Scanner’s Adapter devices 

via the Debug->EtherNet/IP 

Scanner Monitor menu. 

Double-click on any field of 

any Adapter to Enable or 

Disable the I/O cycles of 

individual Adapters, or 

Clear/Reset errors/metrics. 

 

Utilize these EIP_ADAPTER structure/members in Ladder Logic for Protocol level monitoring 

and control common to every Adapter. 

c. EDS Repository 

A set of EDS files are initially installed with Designer.  These can be utilized to help configure 

your Adapter devices.  Third Party EDS files can be Imported into Do-more Designer’s 

Repository from the various Configuration dialogs.  The critical portions of the Project’s EDS 

files are included as part of your Project when written to your PLC.  This way, you do not 

have to have a full Repository when connecting to your PLC from a different computer. 

The EDS Repository Folder is located below the Do-more\Profiles folder below 

Public Documents (C:\Users\Public\Documents\Do-more\Profiles\EDS). 
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d. Support for Explicit Messaging to Adapter Devices 

You can also transact any 

needed Explicit Message 

requests with any of the 

Adapters using the 

existing EIPMSG - Send 

EtherNet/IP Message 

instruction. 

 

2. New Instructions (DmT 2.10) 

a. Expression Relational Contacts (6792) 

 

Enter full MATH-like expressions for both the Left and Right side of the Relational Contact, even 

utilize complex array index expressions like R[((V0 + 3) * 10) + V1]. 

When entering a normal relational contact, just hit the Expression 

button to enter expressions for both Left & Right side of the 

relational contact.  

To help with Value Status, 

enter an optional Result 

parameter for each side, 

showing each side’s 

expression result value in 

the Ladder Status (contact 

cyan ON/OFF status is 

always provided). 

The Result parameters can 

also eliminate the need for a 

MATH box if the Result is 

needed for other logic. 

In this example, R99 is the 

Quadratic Formula “root” 

term (b2-4ac). 
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b. New MATH real-result functions MROUND, FLOOR, CEILING 

i. MROUND(number, multiple) – rounds number expression up or down to the desired multiple 

expression.  Examples: 

MROUND(5.1, 2) rounds 5.1 to nearest multiple of 2 (result 6.0) 

MROUND(4.9, 2) rounds 4.9 to nearest multiple of 2 (result 4.0) 

MROUND(3.14159, 0.001) rounds 3.14159 to nearest multiple of 0.001 (result 3.142) 

Note: New MROUND is different than existing ROUND(number) function, which always 

rounds to nearest whole real number. 

ii. FLOOR(number, significance) – rounds number expression down (towards 0) to the nearest 

multiple of significance expression.  Examples: 

FLOOR(5.7, 2) rounds 5.7 down to multiple of 2 (result 4.0) 

FLOOR(1.58, 0.1) rounds 1.58 down to multiple of 0.1 (result 1.5) 

iii. CEILING(number, significance) – rounds number expression up (away from 0) to the 

nearest multiple of significance expression.  Examples: 

CEILING(5.1, 2) rounds 5.1 up to multiple of 2 (result 6.0) 

CEILING(1.21, 0.1) rounds 1.21 up to multiple of 0.1 (result 1.3) 
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3. (2.10.2) Secure Ethernet Do-more Protocol Communications (BRX only, requires 2.10.2 

firmware and Booter 1.1.2/Gate Array 1.17) 

Each BRX PLC Project can specify whether or not the PLC will require/allow Encrypted or 

Unencrypted Do-more Protocol communications over Ethernet via BRX Primary Ethernet port 

and the BX-P-ECOMEX POM Secondary Ethernet port (see PLC->System Configuration… Internal 

Ethernet Port Security button), along with disabling other Ethernet-based protocols: 

 

These settings do NOT affect Serial or USB communication link connections.  Those are always 

un-encrypted.  See new System Nickname $EthSecrtyPolicy below for current settings report 

accessible from logic. 

 

Online Link Status Bar Description 

 Designer will show a LOCKED icon as part of the Communication 

Link Status Bar Pane when the connection’s protocol session is 

currently using encryption. 

 The pane will show an UNLOCKED icon when connection is 

currently using UNencrypted communication but the PLC is 

configured for using ENCRYPTED over one or both the Ethernet 

ports.  This can happen when the current session’s communication 

link is over Serial, USB, or the “other” un-encrypted Ethernet port. 

The pane will NOT show any icon when doing un-encrypted communication if BOTH Ethernet ports 

allow UNENCRYPTED programming (pre-2.10.2 behavior). 

The PLC’s Ethernet Security settings could affect Do-more Designer Programming, C-more HMI, 

and remote RX/WX Network Read/Write Peer to Peer instructions.  These are all potential Do-more 

Protocol clients talking to your BRX PLC over Ethernet. 



 Do-more Updates Rel 2.10.4, October 21, 2024 

 Page 17 of 50 

4. Enhancements 

a. Security – (DmT 2.10) Expanded password lengths for 

i. System Configuration SMTP (Email) user accounts to 63 characters. 

ii. PLC User accounts to 32 characters; this also requires the BACKUP and RX/WX 

instructions to support longer passwords for their Password parameters. 

b. Project Files – when opening and using .dmd project files within a Designer session, Designer 

now expands the compound files contained within the .dmd file to be below the user’s local 

%temp% folder instead of below the .dmd project file’s folder “temp”.  Switching to the local 

user’s %temp% folder minimizes issues compared to when the project’s subfiles were being 

accessed via a network drive or a virtual drive in the cloud (6839, thanks to GL et.al.). 

c. Ladder View – Options, divided options into two tabbed dialog groups, Display/Status and 

Editor/Mouse. 

d. Ladder View – Instruction Editor Element field width expanded since Element names are 

capable of being very long.  See the Ladder Options/Editor tab to configure this - range is 16 to 

48 characters (default is now 24). 

e. System Configuration – Memory Configuration – User Data Type – added option to 

minimize “nag” dialogs when editing UDTs that have unions or unused DWORDs (6756, 

thanks to RB). 

f. System Configuration – I/O Configuration – EtherNet/IP Scanner – Create Assembly 

Specific UDT dialog (2.10.2) – added Generate Field Names button that auto-generates 

initial 16 character UDT field names for all the currently unnamed fields based on the EDS 

parameter descriptions of that Assembly.  Note that some vendor’s EDS file’s parameter 

descriptions are more appropriate/compatible as field names, so actual milage may vary. 

g. System Configuration – Memory Configuration – EtherNet/IP Adapter Structure (2.10.2) – 

added two new fields UNSIGNED BYTE .MSGSent and UNSIGNED BYTE .MSGReceived.  

The 8 bits within those BYTEs represent the MSG#(minus 1).  So .MSGSent bit 0 turns ON 

whenever MSG 1 T->O is Sent.  .MSGReceived bit 7 turns ON whenever MSG 8 O->T is 

Received.  Your program is responsible for CLEARing those bits. 

h. New Offline Project Dialog – in the Specification List window, bumped the supported 

Expansion Module count for the BX-10 and BX-18 MPUs from 2 to “up to 8 modules” (still 

limited based on power budget, 6789). 

i. Select PLC Connection Dialog – to help with setting Timeout values for remote 

connections, hitting the Blink & Refesh  button for the selected Connection will report 

the communication turn-around time in the Enable column. 
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j. Select Project dialog – added Restore Project from Backup button.  Added Configure 

Autosave button to Restore from Backup dialog.  Backups are automagically saved in addition 

to any explicitly Backed Up Projects. 

 

k. Ladder View – Allow ranged Math functions to support a block range of a specific field of a 

User Data Type/Structure.  Say you have a BatchLog data block that records temperatures in 

a REAL field called .Temperature.  You can now call AVGR (Average over a Range) inside a 

MATH Expression parameter with the BatchLog’s .Temperature field: 

 AVGR(BatchLog0.Temperature, nBatches) 

This enhancement applies to the following Math functions: AVGR, MAXR, MINR, STDEVR, 

STDEVPR, SUMR, and all the SUMIF* and COUNTIF* functions (6865, thanks to RA; requires 

DmT 2.10). 

l. Ladder View – STRPRINT, EMAIL, DMLOGGER Script Editor to easily add all/most of the 

fields of structure elements to the print script (6765): 
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m. Ladder View – Drum Editor added Step helper buttons to Insert, Duplicate, Remove, 

Move Up, and Move Down to manipulate entire Step Row (6800): 

 

n. Ladder View – For PROGRAM code-blocks with Stages, show the status of the rungs 

containing stage bit in the rung Address area.  Also show the TASK or PROGRAM’s 

.RanThisScan in the Address area.  This can help show the user if the logic in that rung is 

actually being scanned (5960).  Note that some rungs may only execute for 1 scan by design, 

so that Rung’s Address area status may not reveal that short of an event. 

o. Ladder View – Instruction Editor default Output Parameters on new instructions utilize the 

Element Picker’s “Consider Unused elements with Nicknames as ‘Used’ ” behavior when it’s 

checked (6602, thanks to RB). 

p. Ladder View – HWINFO – Get Hardware Information – added queries for module’s I/O 

starting address mappings of any X, Y, WX, and WY points. 

q. Ladder View – MWX – Modbus Write – allows writing a constant value beyond just 1 or 2 

registers, now allows a variable number or more than 2 registers, zero pads beyond 2 (DM655). 

r. Ladder View – MRX/MWX – Modbus Read/Write – support reading and writing a single 

structure via Modbus.  The 16 bit Register Count must match the structure length exactly, so a 

UDT structure 5 DWORDs long would require a Modbus Register count of 10 WORDs.  Heap-

items and nested structures are also supported by this feature. 

s. Ladder View – Print – Added an option for large Tall/Wide Split rungs to start on a New Page 

so that there is better chance that large rung could fit on a single page (6835). 

t. Ladder View – EIPMSG – Send EtherNet/IP (Explicit) Message does not require the IP 

Address or Ethernet Port value when the device is an Ethernet/IP Adapter device since those 

values are implied by the device’s configuration.  Those values from the System Configuration 

will show up as read-only parameters in the editor, and also displayed in the Ladder View. 

u. Ladder View – DEVREAD – Read Device Register (2.10.2) – added 16 new Register types for 

Ethernet/IP Scanner Adapter devices to read the Requested Packet Interval RPI (in 

milliseconds) for each of the 8 T->O MSGs and the 8 O->T MSGs. 

v. Project Browser, Element Picker – added configured maximum string length for all STRING 

elements (e.g. SS0-SS127 .MaxLen=64).  The Project Browser behavior can be disabled in its 

Options dialog (enabled by default). 

w. Data View – added support for Symbolic Constants (useful when generating Data View content 

from Instruction  Monitor Parameters or to/from Trend View; 6751, thanks to GD). 
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x. Data View and User Data Type Field Configuration – changed structure field status detail 

terminology from Short vs. Long to Critical vs. Useful. 

y. Change Value dialog (2.10.2) – updated read/write PLC buttons (6862). 

z. Trend View – start left edge time tick mark on whole second (6795, thanks to CG). 

aa. Trend View, Archive – .trarc file contains trend elements’ nicknames (6760, thanks to RB). 

bb. Memory View – Structure Blocks – added Auto-Fit button  to view’s toolbar that sets each 

fields’ column width based on the widest displayed content for that column. 

cc. Memory View – Structure Blocks – added Write Specific Fields button  to view’s toolbar 

to pick a set of fields and then write all the fields’ values of the chosen columns to the PLC.  

When doing a Write Entire View of a Structure Block, if its layout contains unioned fields (fields 

that overlap in the memory layout), the Write Specific Fields dialog will pop up to prompt for 

which unioned field values has precedence (both cannot be written because last one wins). 

dd. Memory View – Structure Blocks – changed terminology when selecting of number of 

columns within the combo-box from Short/Long/All to Critical/Useful/All based on the 

Structure/UDT’s fields’ Data View Detail settings. 

ee. Memory View – Structure Blocks – import and export Structure/UDT field values to Comma 

Separated Variable (csv) text file (6692, thanks to MF). 

ff. Memory View – Added support for polling STRING blocks with string Maximum Length smaller 

than 252 characters (and any structure block whose element is smaller than 256 characters). 

gg. Memory View – Added String Block element’s Max String Length to Title Bar; abbreviated 

pane tab text but its tooltip expands to full title description; report error condition in the Status 

Bar when floating mouse cursor over a cell with an invalid entry. 

hh. Video Browser Dialog – dialog is modeless, allowing you to do other Designer work while 

keeping it opened (6759). 

ii. Cross Reference View – added support for sparse ranges (like JSONBUILD structure field 

range, 6694). 

jj. New System Status Nicknames 

DST71 $POMMACAddress 

Lower 4 BYTEs of Ethernet co-processor POM MAC address 

(Little Endian; first two bytes of 6 byte MAC are always 

00:E0:xx:xx:xx:xx; requires DmT 2.10) 

DST72 $EthPacketsFree Ethernet stack resource “down/up” counter 

DST73 $EthSecrtyPolicy 
Bit-mask of the current Ethernet Security Policy settings 

(2.10.2, see Help Topic DM0208 System Nicknames details) 

DST414 $CryptoAuthErr 

Do-more Encrypted Protocol Server counter when PLC 

received a packet that failed Decryption or Authentication 

(2.10.2) 

DST415 $CryptoTokenErr 
Do-more Encrypted Protocol Server counter when PLC 

received a packet with an invalid Token (2.10.2) 
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kk. Communication Server – added Cancel button to Link/Connection Sensing startup dialog 

(6844). 

ll. Memory Image Manager – Warn when a Region’s User Data Type is going to be edited in the 

Memory Configuration dialog.  The Region may become invalid with any type of data type or 

memory layout change.  The Region Memory Editor now supports Export/Import of structure 

field values.  When UDT changes are about to be committed, prompt to export the affected 

Regions’ data to a .CSV file so the field values can be tweaked and later imported back into the 

Memory Image Manager Region (6869). 

mm. Device View and Device List View – Show the device’s Heap Item (if it exists).  When 

online, also show the Heap Item’s status in the Device View (4124).  Improved landscape vs. 

portrait layout handling for Device View.  Removed support for Status in Device List View due to 

complexity of requests with the Communication Server. 

nn. Web Server HTTP Header Support (DmT 2.10, BRX & Simulator only) – set any HTTP Header 

text that gets returned as part of any response to an HTTP request from a remote client to the 

PLC’s Web Server.  After enabling the HTTP Web Server option on the CPU Configuration 

panel of the System Configuration dialog, check the Enable User HTTPHeaders checkbox in the 

HTTP Server Settings dialog box.  Then set the HTTPHeaders STRING heap-item in the PLC 

to the desired header text (STRPRINT instruction, Data View, et.al.; thanks to GD). 

oo. Project Export/Import and Clipboard Contents – added support for the new EDS File 

database in a new SYS_CONFIG2 file section. 

pp. Compare Programs dialog (2.10.2) – when comparing against a different project file, 

remember that file name by default so it does not have to be Browsed to again (6852, thanks to 

DS). 

qq. Program Check – New Rules 

i. M133 Information Message – Relational Contact mismatched data types/value ranges 

(6379, disabled by default at Project Level 6799). 

ii. M134 Information Message - Relational Contact equality comparison between two REALs 

may not be accurate (6379, disabled by default at Project Level 6799). 

iii. W462 Warning - OUT coil used in edge-enabled Task code-block.  Since Edge Triggered 

Tasks always terminate immediately, and OUT coils turn OFF when “terminated”, a SET 

may be more appropriate (6679). 

iv. W088 Warning - Memory Image Region(s) inconsistent with System Configuration.  Disk 

Project based Memory Image Region values are not automatically truncated when modifying 

the Memory Configuration where the corresponding Data Block’s Number of Elements is 

reduced.  When the actual Data Block size is smaller than the stored Memory Image 

Region, this rule violation is posted (6816). 

v. E089 Error - Disconnected Module Configuration is referenced by the System Configuration 

where it MUST be connected (e.g. Modbus I/O Scanner utilizing a serial port on a 

disconnected BX-SERIO module configured as a Modbus/RTU Slave, 6775, thanks to AS). 

rr. DmLoader – changed default Ethernet timeout from 100ms to 300ms. 
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5. Adjusted Anomalies 

a. Ladder View – Readonly Parameters in High Speed I/O Hardware based instructions 

(PWMOUT, HSCNT, HSEDGE, HSPULSEC) properly updated I/O references when changing 

High Speed I/O Resources in System Configuration, changes properly reflected in Cross 

Reference View also (6630); DRUM Mask properly reports as a Ranged parameter (6766); 

DRUM Instruction Editor – show Useful Drum Fields (6778); Instruction Editor – properly handle 

creating new Stage box when specifying duplicate Stage Bit elements for On Success/On Error 

JMP to Stage; FILEOPEN Instruction Editor File Handle field editor supports nested File Handle 

structures (6699); GSREGWR instruction only available on PLCs with Ethernet ports; Paste – 

properly restores focus (6784); Print – properly print multiple input boxes when they cross pages 

(6785, 6786); Print – properly paginate with split rungs and rung comments (6837) and other 

print anomalies (6842); Replace – properly handle Replace in HWCONFIG instruction (6769); 

Find Instruction – show entire instruction list in the Instruction combo box drop down when there 

is no leading text for the mnemonic (5189); Ladder Instruction Toolbox properly position at first 

launch (6552); simplified DEVREAD entries for BX POMs (6793); properly handle High Speed 

Edge settings for High Speed I/O instructions; BACKUP instruction – added support for 

Simulator; STRPRINT/EMAIL FmtDate and FmtTime Script Editor Format selection better 

reflects actual format (6817); MATH Editor when Element Picker button is hit for Results field, 

Element Picker dialog is properly shown; EIPMSG Monitor Values in Data View properly ignores 

unused placeholder parameters (6752); RAMPSOAK Editor properly handles invalid keystrokes 

(6748); MSREGRD/MSREGWR properly reports WORD ranges of structure fields (6830, 6831); 

Disable UI during Find All but allow Status to update (6848); Block Cursor movement works 

properly when cursoring to/from large box instructions that do not fully fit in the window (6850); 

When reporting a Short Circuit in an edited rung, report the row/column location of one of the 

contacts being short-circuited (5297); Expression Relational Contact Editor fields properly 

displayed when Nicknames are ON and Elements are OFF (2.10.2, 6882); properly disallow 

read-only string fields in instruction output parameters (2.10.2, 6867); mouse pointer no longer 

flickers back and forth between normal arrow and rung select arrow in the Address column 

(2.10.2, 6885); properly position Output boxes and coils in the Output Column whenever block 

cursor is currently in the contact/input area (2.10.2, 6887); properly handle the Element Browser 

button in the Contact/Coil editor (2.10.4). 

b. Communication – reduced lockups across multiple online Designer instances (6828); startup of 

the Communication Server does not disable Windows Desktop or top window (6843). 

c. Communication/Status – properly handle UDT sub-structure status when UDT is more than 255 

BYTEs. 

d. Select PLC Connection Dialog – reduce PLC querying time (6657). 

e. Project Browser – when displaying a Rung Comment in Code-Block tree, remove any leading 

carriage-returns/spaces since the tree label only shows the “first” line of the Rung Comment. 

f. Protected Code Blocks – never implicitly export protected code (6535); Export Program – 

prompt user when exporting unlocked protected code-blocks (6780). 

g. Launch Pad/Projects Panel and Select Project dialog – better handling of network sourced 

project files (UNC or mapped drive; 6006, 6061, 6772, thanks to JM, FD). 



 Do-more Updates Rel 2.10.4, October 21, 2024 

 Page 23 of 50 

h. Element Picker – When choosing to flag Unused Elements with Nicknames as Used (X in the 

usage grid), apply that to the behavior of the Find Next/Previous Used/Unused buttons behavior 

(6790). 

i. System Configuration – Serial Port Configuration – when changing from Modbus Client, ensure 

device is currently not part of the Modbus Scanner configuration; validate existence of all 

Modbus I/O Scanner devices, also properly handle when Modbus I/O Scanner device is 

missing; User Data Types – do not allow UDTs to have same name as existing Built-In pristine 

names (6797, thanks to JO); User Data Types – do not accept an import of a UDT with too 

many fields (6864, thanks to SM); I/O Configuration BX Universal Analog Units/Count on 5V 

range works properly; User Data Types – report when the UDT configurations exceed the 

reserved configuration area size (e.g. 80+ UDTs of 30+ fields each; 6791, thanks to CJ); IP 

Address Configuration – DHCP only supported on BRX (6807); Module Configuration – disallow 

digit as first character of Module Configuration Name and Device Name (6781); disallow empty 

Device Name; Module Configuration – properly displays BX-xxTHM Type E thermocouple Low 

degC range (just a Designer display issue, not an issue with the module or PLC firmware, 

6812); adjusted invalid Device name error message (limited to 15 characters, 16 counting the 

"@", 5263); better online status handling of modifications to UDT schemas or dynamic system 

schemas like BRX HSIO Counter/Timer structures; shortcut access to device editors got a little 

smarter with non-Ethernet-based PLCs; properly handle data lengths when encoding specific 

parts of the system configuration (2.10.2, thanks to AM); EtherNet/IP Scanner Adapter Settings 

– Create Assembly Specific UDT dialog Parameter List Box is properly Single Selection 

(2.10.2); EtherNet/IP Scanner Adapter Settings – set EDS Configuration length to 0 whenever 

the Configuration Path is provided but a Configuration Length is not provided (2.10.2, DM-699); 

Memory Configuration – ensure consistent size between Raw and Scaled Analog data blocks 

WX/RX and WY/RY (2.10.2); properly handle change of CPU Serial Port configuration from 

Modbus/RTU Client (2.10.3, DM-701); Memory Configuration - passively update Raw/Scaled 

Analog data block sizes when they are out-of-synch (2.10.4); EtherNet/IP Scanner Adapter 

Settings – properly handle EDS Configuration length (2.10.4). 

j. System Information – File System Error Reporting provides more detail. 

k. Cross Reference View and Find – properly ignore unused placeholder parameters (6821, 6859). 

l. I/O System View – better handling of background communications while re-sizing the view 

(6758, thanks to MG); proper handling of module warning status communications (2.10.2, 

6829). 

m. Data View – properly handles request to no longer nag about saving Temporary Data View as a 

disk file. 

n. Program Check – Warning 130 Writing to High Speed Output Y via instruction properly reported 

(6768). 

o. Documentation Editor/Database – better handling of inconsistent records (6770); properly 

handle implied Nicknames of cast and struct member forms of a Nickname; handle narrow 

resizing of Documentation Editor. 

p. Select Project Dialog – loads faster by adding option to not query Project’s Link/Connection 

details (6664). 
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q. Element Picker – properly handle F9 keystroke to launch Element Browser from the Element 

Picker; Element Browser from Element Picker is useful to document “picked” element and/or 

utilize the Cast Builder feature (6762). 

r. Connect to PLC – better handling of Instruction ID/Edge Bit differences (6516, 6773); properly 

handle User Data Type and Memory Configuration differences (6734); properly update local 

Instruction ID/Edge Bit when programs match (6827). 

s. Simulator – better handling of launching the Simulator (6801). 

t. Communication Server – better handling of USB devices (6777). 

u. Parameter Ranges (Find) – properly handle sparse ranges like JSONBUILD struct field range 

across IDs along with other Find Range issues (6695; still an issue with Cross Reference 

Expanded Range). 

v. Tools – properly handle launching Debug tools (6798, thanks to CH). 

w. Memory View – Structure Blocks – Initial Field column widths fit to their content; properly update 

title text when modifications are made to the Memory Configuration. 

x. Memory View and Memory Image Manager Block Editor – properly handle various sizes of 

signed integer data types formatted as hexadecimal and octal, e.g. FF for Signed Byte, FFFF for 

Signed Word, FFFFFFFF for Signed DWord (6811) 

y. Memory Image Manager – properly handle STRING data blocks as a value type like bit or 

numeric, not as a structure with fields (6805, thanks to E); Utilize a modal Operation Status 

Dialog when reading or writing Regions from/to the PLC. 

z. String Status – when doing status on a corrupted String (incorrect .MaxLength or invalid 

.Length), reveal that to the user in the status text. 

aa. Trend View – continues to monitor values after second instance of Designer attempts to utilize 

same Connection/Link (also affected Link status in Launch Pad’s Link Panel; 6710, thanks to 

RB). 

bb. Data View and Trend View – Various instructions’ Monitor Values set of parameters have been 

adjusted (6752, 5535, DM-159). 

cc. Do-more Technology Versions dialog/Software Versions dialog – append “labeled Windows 11” 

text next to the reported Widows 10 text (yes, Microsoft reports Windows 11 as Windows 10). 

dd. Status Bar – Offline PLC designation pane properly shows tooltip that clicking on the pane 

brings up the Offline PLC Setup dialog. 

ee. Resolve Online/Offline Differences Dialog – for projects flagged to compare Memory Image 

Regions, point users to the Compare Memory button on the dialog when differences are found 

in the Memory Image Configuration/Data. 

ff. Memory Import – requires commas to separate values. 

gg. DirectLOGIC Migration tool - properly supports DL-262 CPU DirectSOFT Projects (6825); 

mentions additional Do-more Immediate instructions that are helpful when utilizing DL 

Immediate contacts (6813). 
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hh. Video Browser dialog – ensure proper modality when launched from Help menu versus a modal 

dialog’s System Menu (2.10.2, 6888) 

ii. Fixed some F1 Help hot key in certain dialog boxes (2.10.2). 
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1. Modbus I/O Scanner (BRX/Simulator only, requires Do-more Technology version DmT 2.9) 

Do-more BRX and Simulator PLCs can use the Modbus I/O Scanner to process Modbus Read and 

Modbus Write requests similar to the way it handles local I/O and Ethernet Remote I/O. It does this 

by creating a Scanner Device for any combination of up to 32 Modbus/TCP and/or Modbus/RTU 

servers/slaves. The Scanner Device can additionally perform any required format conversion on the 

data, eliminating the need to add ladder logic to process the data before it is sent or after it is 

received. 

 

A customized set of I/O for each individual server/slave is defined such that the Do-more PLC 

sends Modbus Read and Write Function Codes as part of its I/O cycle by specifying the set of 

Modbus Data Types and Addresses (Coils 0xxxx, Discrete Inputs 1xxxx, Input Registers 3xxxx, 

Holding Registers 4xxxx).  No programming is necessary for these configured background I/O 

updates. 

In addition to the background I/O, individual slave parameters can also be specified for event-

based requests using the new MSREGRD and MSREGWR instructions (see below) for 

configuration or other non-polling data. 

Some predefined Modbus Device Profile files for common Modbus products are included, like 

GS Drives (no need for GS-EDRV100), Sure Servo Drives, STRIDE Analog and Temperature 

modules, even “generic” profiles for other Automation Direct PLC lines like Click and DirectLOGIC, 

making it much easier to monitor and control these devices from your Do-more PLC. 
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a. Modbus I/O Scanner Monitor (Debug menu) 

After the Modbus I/O Scanner is configured and running, the Modbus Scanner Monitor can be 

used to display the "health" of the currently configured network of Modbus Scanner Devices. 

 

2. New Instructions (DmT 2.9) 

a. MSREGRD – Modbus Scanner I/O Register Read 

MSREGWR – Modbus Scanner I/O Register Write 

(Ethernet BRX/Simulator only) 

Used in combination 

with Modbus I/O 

Scanner devices for 

non-polling Modbus 

Server/Slave device 

parameters, like writing  

configuration 

parameters or reading 

static information like 

Model Number, or any 

other event-based data 

access. 

 

Filling in the Function Code and Modbus Address values for these instructions is much more 

useful when used with pre-defined Profiles that have their many parameters also defined such 

that you can use the Browser mechanism on the left side that then fills out the information on 

the right side.  Regardless, any valid Modbus Function Code and Address can be manually 

entered on the right side of the form. 
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b. HSEDGE – Precise Edge to Edge Timing 

Provides a Ladder Logic reference to your BRX 

High Speed Timer function (5551). 

 

c. HSCNT – High Speed Counting 

Provides a Ladder Logic reference to your BRX 

High Speed Counter function (5551). 

 

d. HSPULSEC – Catch Pulse Input 

Provides a Ladder Logic reference to your BRX 

High Speed Pulse Catch function (5551). 
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3. Nested Structures within User Data Types 

Add other structures to your User Data Types like 

Strings, Timers, Counters, PID, Date/Time, et. al., in 

addition to your other User Data Types.  Multiple 

structure members of most built-in and UDT structure 

types can be added to a UDT. 

So a RecipeStruct UDT can have a nested .Name 

String field and a .CookTimer Timer field, then have a 

block of 50 Recipes and reference 

Recipe42.CookTimer in a TMR instruction, or 

CurrentRecipe.Name heap-item in a report, or use 

Recipe[V7].CookTimer.Acc in a MOVE box. 

Note: Nesting is limited to one additional structure 

level, so you cannot embed a UDT that contains other 

structures inside yet another UDT.  Structures with 

just bit and numeric fields can be embedded within 

UDTs, like a Timer structure embedded inside a 

Recipe UDT, Recipe42.CookTimer.Acc.  However, 

Recipe42.Control.CookTimer.Acc (note Control 

structure level) is not supported because Control 

structure contains a (Timer) structure.  Also, some 

complex built-in structures are not nestable like 

Programs and Axis. 

 

4. Enhancements 

a. Element Field Auto-Complete ID Edit – when you arrow down or select an Element Range 

from the Auto-Complete list, the edit control automagically selects the text characters of the ID 

range to make it easy to enter the actual ID: 

  
In the above example, after selecting the C0-2047 item from the Auto-Complete list, the next 

keystroke will replace the selected text in the edit field 0-2047 with the entered number 

keystroke.  You used to have to manually edit the text of the ID range, which required a 

combination of various keystroke sequences of Arrow keys, Shift key, Delete key, and/or mouse 

actions (5943, thanks to CA). 

b. Ladder View – warn when using a Standard Input or Output in High Speed instructions that 

specify speed parameters faster than 2ms or 500Hz (6609).  For example: warn when setting 

the Maximum Velocity parameter to 1000Hz in the AXCONFIG for an Axis device that is bound 

to a Standard Discrete Output (1000Hz would only work with a High Speed Discrete Output). 
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c. Ladder View – COPY instruction now supports copying a range of strings between blocks that 

contain strings of different Maximum Lengths (6594).  STRCOPY warns when the Source string 

literal is too long to fit in the destination string element.  Improved COPY instruction’s warning 

and error reporting. 

d. Ladder View – FILE* instructions do not support arrays for the File Handle Struct parameter. 

e. Ladder View – Find dialog added a checkbox to Close dialog on Find (5607). 

f. Ladder View – Comment Editor dialog supports setting the default Font size for when you 

create a new Rung Comment.  Factory default is Medium, so it can be changed to Small, Large, 

or Huge (6643). 

g. System Configuration – BRX POM Configuration has been moved from being part of the 

CPU Configuration to being its own tabbed dialog (accessed from the CPU Configuration Entry 

page of the System Configuration dialog): 

 

As new BRX POM modules are developed, their configurations will be added to this dialog. 

h. System Configuration – Memory Configuration Entry/Structs (Built-In/UDT) page, 

Attributes column designates which Structures are Nestable (N) and which ones are Deep (D) 

(see Nested Structures within User Data Types above). 

i. System Configuration – made the Server Whitelist Settings dialog easier to use. 

j. Global Options – added options whether to auto-generate Project Export files and C-more 

Export files (6093). 

k. Element Picker – added checkboxes for classifying certain Unused Elements as Used (6602): 

 *  Unused Elements within Ranges 

 *  Unused Elements with Nicknames 

l. Change Value dialog – when entering a structure field that has a custom format by default (say 

a timer accumulator), automatically choose that custom format display/editor (6704). 

m. Memory View – added support to edit fields of structure blocks (6629).  For REAL fields, added 

support for Exponential format like 6.02E+23. 
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n. Documentation Editor –Added a Text Filter mechanism to reduce the viewable set of records.  

The Filter dialog is mode-less in that you can continue to do other work in Designer while 

maintaining that Filter in the Documentation Editor.  It auto-hides as you are doing other work 

away from the Documentation Editor - just click on the Document Editor to bring it back. 

 

o. Documentation Editor – Added Go To Logic button that brings up the first occurrence of the 

selected Doc Editor Element in Ladder Logic: 

In this example, 

clicking the Logic 

button with C0 

record selected will 

open $Main code 

block to address 

18, the first 

occurrence of C0 

in Ladder logic. 

 

p. Documentation Editor – Add Documentation Record dialog Nickname field automagically 

replaces spaces with underscores as you type (6640). 

q. Trend View, PID View – added a Reset button that clears only the graph on the screen and 

starts trending on the left edge (3979).  The collected set of timed data point values is still 

maintained, which can be viewed by changing the time scale or going into Historical mode. 
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r. Dockable/Floatable Views – added Help Topic DMD0500 Docking and Floating Views that 

provide details about how to manipulate your Designer work environment.  Whether you have a 

multi-monitor system where you float multiple groups of multiple Data Views outside the 

Designer main window, or your development system is on the opposite extreme where you have 

a small laptop screen, so you need to maximize Ladder View real estate, but you need your 

Project Browser and Cross Reference views to be easily accessible using the auto-hide 

mechanism where just floating your mouse cursor over the tab reveals it, but then it auto-hides 

when you move the mouse cursor away (4031, thanks to MN). 

s. Constants – added Help Topic DMD0499 Using Constant Values that describes the best use 

of constants, constant formats, status data formats, and Symbolic Constants (4279). 

t. New System Status Nicknames 

ST156 $QueueFull 

Turns ON after a Queue Load instruction (FIFOLOAD, 

LIFOLOAD) attempts to add a new entry to a full queue (2.9.3, 

requires firmware 2.9.4) 

DST412 $AssertCode 
Should be 0;  non-zero value indicates a firmware diagnostic 

code 

DST413 $ForceMinScan 
Minimum Scan Time in microseconds; ensure PLC scan time will 

be at least this long (actual scan time can be longer) 

u. Contact Mnemonics – enhanced Help Topic DMD0186 Instruction Set for Do-more CPUs that 

list out all the contact mnemonics for each contact type (6100, thanks to DB). 
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5. Adjusted Anomalies 

a. Documentation Editor – properly show Element Documentation Records after sorting or filtering 

(2.9.4, 6754, thanks to RB); properly handles Paste operation with a large Element 

Documentation Database that utilizes an Operation Status dialog (2.9.3). 

b. Simulator – FILE* instructions properly report file status to FileHandle struct; when changing 

PLC modes, properly manage files that are open (2.9.4, thanks to KK). 

c. Replace Dialog – better handling of List of items; after hitting Add to List button, move keyboard 

focus back to Replace edit field (2.9.4, 6753, thanks to GD). 

d. FIFO/LIFO Queue Full Diagnostic – new error when attempting to add a record to a full queue; 

see new ST Bit System Nickname $QueueFull ST156 (2.9.3, requires firmware 2.9.4). 

e. PLC Mode Change Dialogs - support asynchronous mode change behavior along with better 

error reporting (2.9.3). 

f. System Configuration – Edit Modbus I/O Scanner supports ordering the Modbus Comm and 

Modbus Field nodes in the configuration tree using Move Up/Down buttons (2.9.4, thanks to 

GD);  Edit Modbus I/O Scanner Local Element entry field properly allows Read Only structure 

fields, and properly disallows array elements (2.9.3);  Updated SMTP Client Settings Test 

Settings (2.9.3);  Edit Modbus I/O Scanner Device dialog lets you add a Modbus/TCP Client 

device using the new Add button next to the Modbus Client dropdown box (2.9.2); Modbus I/O 

Scanner Profiles support Coil Read/Write and Input Read (2.9.2); automatically bind Modbus I/O 

Scanner Profiles to current Modbus I/O Scanner Devices (2.9.2); enabled Help(F1) button in 

various dialog boxes (2.9.2); Serial Port Physical Layer configuration (RS-232/RS-485) 

propagated properly when PLC CPU types change (2.9.2). 

g. Ladder View – STRPRINT Script Editor properly allows exclusion of Thousands (Comma) 

Separator in FmtReal command (2.9.4); JMP instruction description changed to Transition From 

This Stage to better illustrate that JMP is NOT an assembly language type Jump/Goto, but a 

higher level SFC-like transition (logic below enabled JMP within containing Stage still executes 

on that transitioning scan, 2.9.4);  properly handle Replace of a structure with a nested structure 

(2.9.3, 6743, thanks to RB); after Replace, adjust contact/coil/box size (2.9.3); 

MSREGRD/MSREGWR added Range details to Name/Description column (2.9.3, 6741); 

MSREGRD/MWREGWR support for Copy of whole structures and range structure fields (2.9.3); 

MSREGRD/MSREGWR Monitor Values handles table parameters (2.9.3, DM-609); 

MSREGRD/MSREGWR editor properly updates Profile Parameter Table after changes are 

made (DM-610); proper handling of placement of New Toolbox dialog box (2.9.3, 6552/6553 

thanks to BC); FIFO/LIFO Queue Status proper handling of unwritten changes to queue block 

size (2.9.3); proper handling when editing elements in a table-based instruction with IDs that are 

out of range after a block size change (2.9.3); STRSUB – warn when inconsistency exists 

between Input and Output Strings’ Maximum Lengths, Offset, and Length parameters that could 

cause unexpected truncation of desired Output String (2.9.3, 6728/6745); MATH – added 

Element Picker button for Expression field that lets you easily browse for element names since it 

is a free-form editor and not auto-complete (or just hit F9 key) (2.9.3, thanks to RB); Report 

Control editors properly handle launching Element Browser using F9 key when Element Picker 

is already opened (2.9.3);  proper handling MRX/MWX status display when range of 2 16-bit 

Registers are transferred to/from a complete 32-bit integer or real (2.9.2). 
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h. Connect to PLC – converting PLC Opcodes to Element properly handles array of a BYTE or 

WORD struct field (2.9.2). 

i. Edit User Data Type - when connected to a PLC, and Designer’s Memory Configuration 

becomes incompatible with what is currently in the PLC, disable Online Status (2.9.2). 

j. Element Text Entry – properly handles PL array reference like PL[V42] (2.9.2). 

k. Program Export/Clipboard/Copy/Paste – export nested UDT definitions before the deep UDT 

that references them (2.9.2); properly handle nested UDT structures when pasting (2.9.2); 

properly set Disk and PLC Modified flags when pasting a clip that changes System/Memory 

Configuration (2.9.2); optimizations on Paste (2.9.2). 

l. Project Browser – Adjust Force subtree entries when Designer and PLC Memory Configurations 

become incompatible (2.9.2). 

m. Ladder View – MEMCOPY instruction, wrong error message if source or Destination parameter 

is unassigned struct (6578). 

n. Efficiently print multiple row rungs across multiple pages (6619). 

o. Ladder View – PWMOUT instruction’s High Speed Discrete Output parameter that is not 

entered explicitly (it is implicitly based on the entered PWM Device parameter) shows up in 

Cross Reference (6630). 

p. Ladder View – MRX/MWX instruction’s valid range for Number of Modbus Elements properly 

based on the Modbus Function Code.  For example, Read Coils range is 2008 Bits, but Read 

Holding Registers range is 125 Registers (6625); MRX/MWX editor properly handles IP Address 

field when changing device from a Modbus/TCP Ethernet port to a Modbus/RTU serial port 

(6651).  MRX/MWX Do-more Range parameter’s Element Picker and Auto Complete list reflect 

the valid ranges based on the current Function Code (6677).  Properly show sub-range in 

Ladder Display using casts (e.g. D0:W0) when Modbus Register Count is odd.  MWX Do-more 

Range properly handles constant Do-more parameter. 

q. Ladder View – RX/WX Remote Memory Block, Built-In field editor no longer setting Remote 

Built-In elements to the local project’s nicknames (6701) 

r. Ladder View – DATAINFO – Query Information about Data Memory instruction, corrected 

wording of Heap Item Information Type entry Number of DWORDs to Number of BYTEs in 

Heap Item.  The instruction in the PLC always has returned Number of BYTEs for that entry, 

even though the wording in Designer was not correct. 

s. Ladder View – Common Timer editor properly limits Timer types within a Subroutine (6667). 

t. Ladder View – added support for bit memory cast as numeric in the FIFO* and LIFO* Queue 

instructions (6639). 

u. Ladder View – STREAMIN warns when Data Destination Numeric Data Block Buffer Size in 

Bytes value is smaller than Complete when Length is value (6669). 

v. Ladder View – MEMCLEAR validates the parameter range (6671).  MEMCLEAR box width 

displays correctly.  MEMCLEAR status display optimized (6690). 

w. Ladder View – do not allow array references for File Handle parameter in FILE* instructions 

(6685). 
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x. Ladder View – Print/Print Preview no longer trims off wide boxes.  When returning back to the 

Ladder View, the width of those boxes are displayed properly (6627). 

y. Ladder View – as editing various parameters, properly set inter-dependent dynamic parameter 

ranges (6677, 6650). 

z. Ladder View – constrain set of Timer types in Common Timer when inside a Subroutine (6667). 

aa. Ladder View – proper display of instructions after a Print Preview (6627). 

bb. Ladder View – added confirmation dialog to Replace operation (6649, thanks to GD). 

cc. Project Browser - properly shows dynamic system structure schema changes like when adding 

scaling to a High Speed Counter/Timer resource (6628). 

dd. Project Browser – Properly show dynamic updates to the Memory Configuration. 

ee. System Configuration – Edit User Data Type dialog properly handles DEL key when editing the 

Structure Name field (6645). 

ff. System Configuration – SMTP Client (EMAIL) dialog properly initializes Port field after 

re-opening dialog. 

gg. System Configuration – ensures device name’s heap item name does not conflict with an 

existing heap item (6683). 

hh. Project Files – warn when an entered Project file/folder name or a Designer Folder Setting 

name is too long for Window’s file system (6634). 

ii. Data View – properly handle Offline Data View when Connecting to a PLC (6706). 

jj. Trend View – properly restores the Minor Tick Mark count (6654). 

kk. Memory View – need to unconditionally close UDT based Memory View when the UDT 

definition itself is modified via the System Configuration dialog. 

ll. Memory View –upon opening a Disk Project whose Memory Configuration is incompatible with 

its associated PLC Project, do not open any incompatible Memory Views. 

mm. Clear PLC Dialog – keep the dialog open if any issues are reported. 

nn. BRX Axis status – changed unconfigured status text from <disabled> to <unconfigured>. 

oo. JSON Pretty Print – properly report Windows DOM object failure (6665, thanks to BG). 

pp. Status Updates – adjusted Designer’s Communication Update mechanism to better handle 

status update bursts (6670). 

qq. Write to PLC – properly verifies PLC mode when required to switch to Program mode. 

rr. Close Project – all view types are properly queried about any pending changes before closing. 

ss. Export Element Documentation – properly handling used vs. unused options and C-more export 

options (DM-590). 

tt. View Status – try to govern status update overload when the application GUI starts becoming 

unresponsive. 
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8. New Hardware (these require Do-more Technology Version 2.8) 

BX-P-ECOMEX 

BRX POM: Secondary Ethernet port 

• Client capabilities: Ethernet I/O Master, EMAIL(SMTP), MRX/MWX, RX/WX, 

DLRX/DLWX, HTTPCMD, MQTT(PUB/SUB), DNS, PING, EtherNet/IP™ Explicit, 

FTP(GET/PUT see below), SNTP, STREAMOUT, PACKETOUT, PEERLINK, 

GSREG(RD/WR) 

• Server Support: Modbus Server, EtherNet/IP™ Explicit Server, HTTP Web Server 

(see below), TCPLISTEN, PEERLINK, STREAMIN, PACKETIN, 

Do-more TimeSync,  … 

• Supports DHCP (added DHCP to Primary Internal Ethernet Port also) 

BX-HSIO4 

Similar to BX-HSIO1/2 High Speed Discrete I/O module except: 

• Input Frequencies up to 2,000,000 Hz (8 times faster) 

• Output Frequencies up to 2,000,000 Hz (8 times faster) 

• Input and Output Type: Differential TTL 

• Nominal Voltage Rating: 5 VDC 

BX-16NF3 BRX 16 point TTL Input, Sinking/Sourcing, 2 5 VDC 

BX-16TF2 BRX 16 point TTL Output, Sourcing, 20 mA @2-5 VDC 

BX-16CF3F2 BRX 16 point TTL Combo, 8 pt. Input Sinking/Sourcing, 8 pt. Output Sourcing 

BX-08TRZ BRX 8 point Relay Output, Dry Contacts 

BX-16TRZ BRX 16 point Relay Output, Dry Contacts 

BX-05TRS-1 
BRX 5 point High Current Relay Output, Form C, 8A @12-48 VDC, 24-240 VAC, or 

0.5A @100-125 VDC 

 

9. EtherNet/IP™ Adapter w/Implicit Messaging (Ethernet BRX/Simulator only, DmT 2.8) 

Configure up to 8 blocks of 4 Adapter Pairs 

as an EtherNet/IP Adapter, utilizing Implicit 

Messaging for real-time control by your 

Scanner device. 

For each Adapter Pair, the odd numbered 

Block can be configured as T2O, and the 

even block can be configured as O2T.  

Blocks can also be configured for Explicit. 

In addition to numeric/bit data blocks like N 

or C, blocks can be also tied to data blocks 

of Structures, and to User Data Type and 

Heap-Item structures, providing for a true 

object instance interface. 

Generate the BRX’s Electronic Data Sheet 

file with the push of a button to easily 

interface your configuration with your 

EtherNet/IP Scanner.  
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10. HTTP Web Server (Ethernet BRX/Simulator only, DmT 2.8) 

Ethernet-equipped BRX CPUs have an 

on-board web server that can be 

accessed by any web browser using the 

IP address of the BRX CPU as the URL. 

The CPU's web service has a REST 

API allows access to the memory 

elements in the BRX CPU from any web 

browser or other web client 

programming package.  The on-board 

web server uses the REST API to 

automatically build several web pages 

that can be displayed in a web browser. 

Once the web server has been enabled 

in the System Configuration, the main 

web page in a BRX CPU can be opened 

with any web browser, simply enter the 

TCP/IP address of the CPU as the URL.  

Info: basic information about the PLC and its current state 

Status: any current Info, Warning, and Error messages 

I/O: current status of local discrete and analog I/O, updated once per second 

Data View: a configurable table of selected element status locations, updated once per second 

SysLog/UserLog: the current System Log and User Log tables 

For details about the Web Server, see the Help Topic DmD0481 The Web Server. 

 

REST API 

The REST API can return the contents of any PLC memory location in JSON formatted records. 

The REST API is accessed using a URL with the appropriate parameters. 

The format of the URL is <PLC-IP-Address>/data/json?<client-name>=<do-more-element>, for 

example: 

 192.168.10.42/data/json?MyScanCounter=DST0 

and will respond with a JSON object containing the client-name and the element's data value: 

 { 

 "MyScanCounter":14437656 

 } 

The REST API URL supports lists of elements, a range of elements, even structures as embedded 

JSON objects with Do-more structure field names as the nested object’s field names. 

For all the details about the REST API, see Help Topic DmD0482 REST API. 
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11. New Instructions (DmT 2.8) 

a. FTPGET – Retrieve File FROM Remote 

FTPPUT – Store File TO Remote 

(Ethernet BRX/Simulator only) 

The FTP functionality is FTP Client only (not Server).  The BRX PLC can GET(read from) and 

PUT(write to) files between a remote FTP Server and the PLC’s File System. 

 

 

b. SGSETI - Indexed Enable Stage 

SGRSTI – Indexed Disable Stage 

Similar to the capabilities that JMPI (Stage Indexed JMP) provides, this pair of instructions lets 

you Enable or Disable another Stage indirectly via a variable index of a range of Stages.  In the 

examples below, if D0 equaled 3, then S3 would be Enabled (or Disabled).  While JMPI also 

transitions OUT OF the CURRENT Stage, the SGSETI/SGRSTI will NOT transition out of the 

current stage, but just enable/disable the other stage. 

 

 

c. DMLOGGER – Broadcast String to DmLogger.exe 

Combines the need for 

selecting a Network 

Adapter for BRX Secondary 

Ethernet Port to broadcast 

the string to any PC with 

DmLogger.exe listening, and 

the need for Print Script 

capabilities. 
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d. HWCONFIG – Configure Hardware (BRX Local Only) 

You can now manipulate certain I/O Configuration settings at runtime.  For example, the 

on-board Analog I/O voltage/current setting(s) is normally configured statically in the System 

Configuration, but the HWCONFIG instruction can change those settings dynamically at 

runtime.  So you can change an Analog Input from unipolar 0-5V to bipolar +/- 10V. 

 

Manipulate High Speed Input Filter times, set Thermocouple Probe Types, et. al.  Not all BRX 

modules are configurable at runtime.  Some of the supported modules are MPU Onboard, BX -3 

Analog Input/Output/Combo, and BX-HSIO.  See help topic DmD0488 for details. 

e. TESTNUM – Classify Numeric Value Types 

Sets the Value Type to one of five possible 

“types” based on the Input Value (thanks to PK). 

 

Tests REAL Input Value for IEEE 754 Floating Point classifications of Not A Number(0), 

Plus/Minus Infinity(1), Plus/Minus Zero(2), Subnormal(3), and Normal(4) Value Types. 

Tests INTEGER Input Value for Min/Max Integer(1), Zero(2), and Normal(4) Value Types. 

12. Server Whitelist support (Ethernet BRX/Simulator only, DmT 2.8) 

per Server function, lets you 

specify a Whitelist of IP 

Addresses and/or IP Address 

Ranges allowed for that 

specific function. 

PLC->System Configuration… 

CPU Panel, Whitelist Settings 

button. 
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13. Table Based Script Editor for STRPRINT, EMAIL, and DMLOGGER (6431) 

The original editors’ multi-line 

text editor required knowing 

the function names, 

parameters, and keywords. 

The new editor is table-based 

with intelligent form command 

entry, making it easy to see 

all the options for all the 

different Print Script 

commands. 

(To switch back to the 

Text-Based editor, just hit the 

button at the bottom).  

 

In the Table Editor, when you 

add/edit a new function, you 

get a smart form that lets you 

fill out that specific function’s 

parameters, like Justification 

of Left/Right/Zero Pad for the 

FmtInt - Format an Integer 

command. 

 

Select a new function from the Format String Function list, the form will adjust to THAT function: 
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14. Enhancements 

a. Install – migrate Recent Projects List from any previous installation (6312, thanks to JT). 

b. Ladder View – Ladder Editor now allows Master Relay type rungs. 

In this example, X0 enables or disables 

3 other sub-rungs, which drive 3 

different coils based on the state of 

other switches and a timer. 

The Master Relay pattern can be 

nested within the same rung. 
 

This eliminates the AND-ABOVE-JOIN Ladder Editor compiler error (6444, thanks to every 

customer since 1994). 

c. Ladder View – added F1 Help functionality to the Ladder Editor’s compiler errors that are listed 

in the Output Window. 

d. Ladder View – Instruction Editor (general) 

when hitting the Browse Element button on any Instruction 

Editor toolbar, always launch the original Element Browser 

dialog box for the current edit field (6550).  

e. Ladder View – added support for string literals in COPY and CALL instructions (6253, thanks 

to TGM, et. al.). 

f. Ladder View – Network Adapter selection in specific Ethernet TCP Client Instructions is 

typically implied by the entered Server’s IP Address and then is routed based on the configured 

Subnets of the Primary and the Secondary Ethernet ports.  However, when TCP broadcasts 

must be utilized, or for internal configuration, a Network Adapter must be selected.  The 

following instructions added Network Adapter selection: PEERLINK, PACKETOUT, PING, 

SETUPIP. 

g. Ladder View – added Mini-Trend to RANGECHECK instruction (6454) 

 

h. Ladder View – Instruction Specific Tools  

i. RUN, ENTASK, CALL and TCPLISTEN: open the referenced code-block’s Ladder View. 

ii. MATH: show Function help topic, STRPRINT/EMAIL: show Print Script help topic (6453). 

iii. JSONPARSE: JSON Pretty Print for the non-numeric Found Value parameter (6599). 

i. Ladder View – JSONBUILD, STRCOPY – support string heap-items when the Count 

is 1 (requires DmT 2.8, 6559). 
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j. Ladder View – PID instruction Deadband 

PID supports a second type of Deadband behavior.  

The original behavior (Type 1) freezes the Error term 

while it is within the Deadband value.  The new 

behavior (Type 2) Zeros-Out the Error term while the 

calculated PV-SP Error term is within the Deadband 

value (6481, thanks to MM). 

 

k. Ladder View – AXCONFIG instruction editor 

Has dynamic graphic 

to help explain the 

specific behaviors of 

the Axis’s reported 

position based on 

the three possible 

Encoder Feedback 

settings: 

• No Encoder 

Feedback 

• Position based on 

Encoder Count 

(Closed Loop) 

• Position based on 

Pulse Output 

(Open Loop)  

l. Ladder View – added OK/Cancel/Help buttons to all the large instruction editors that did not 

have them (HTTPCMD, AXPOSSCRV, AXPOSTRAP, AXHOME, AXCONFIG, EIPMSG; 6026). 

m. Ladder View – DEVREAD/DEVWRITE supports the various FTP device parameters. 

n. Ladder View – warn when editing Interval Time Based configured device instructions that utilize 

Stage Transition On Success/Error (MRX/MWX, RX/WX DLRX/DLWX, EIPMSG, MQTTPUB).  

These instructions report “Success” or “Error” at every time interval (since they technically never 

complete), so JMPing out of a stage of a recurrent time based instruction would cause that 

instruction to “terminate” the very first time, and hence never get a chance to run the interval 

time to do it a second/third/fourth recurrent time (6320, thanks to GD). 

o. Ladder View – AXSCRIPT and Print Script command entry dialogs – added Help (F1) button. 

p. Ladder View – adjusted JSONBUILD instruction editor Output Record group box border. 
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q. System Configuration – modified the CPU Configuration panel layout.  Streamlined 

TimeSync mode, added Initial TLS TimeSlice setting, moved configuration of the Modbus/TCP 

Server to its own dialog box, changed EtherNet/IP section to include EtherNet/IP Adapter, 

added Web Server and TCP Server Whitelist Configuration buttons. 

r. System Configuration – Setup (BRX High Speed) Match Register dialog has note next to 

“this value” field, to utilize the INTCONFIG instruction if the Match Register value needs to be a 

variable (the static configuration only accepts constants, 6588). 

s. System Configuration – MQTT Broker Configuration supports empty passwords. 

t. System Configuration – Configure FTP Client Device (Ethernet BRX/Simulator, DmT 2.8) 

PLC->System Configuration… 

Device Configuration Panel 

 

u. Memory View - added support for Structure data blocks, READONLY (6209): 

 

v. File->Project Options 

File->Project Options… lets you tweak project 

specific Designer behaviors, like filling out the 

Code Block Configuration dialog when you create 

a new Program.  These options are configurable 

PER project, but you can define your own 

“default” options for new or for existing projects 

that don’t yet have any Project Options (6442).  
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w. JSON Pretty Print 

Supports nesting-level based 

background colors (6513). 

 

x. Dump File – Dump File message box prompts to open Windows Explorer to the .dmp file 

location (e.g. c:\users\Public\Documents\Designer2_8\Bin) and selects that specific .dmp file 

inside Explorer (6482). 

y. DmT 2.8 Firmware Enhancements: 

i. DST68 ($TLSTimeSlice) – the amount of time per PLC scan in MICROseconds for 

running the TLS/SSL security state machine in the PLC.  Some remote servers limit the 

amount of time a client has to perform the TLS handshaking.  By allocating more time per 

PLC scan, more work can be done per scan, reducing the total amount of time to establish 

the secure connection. 

z. Program Check – New Rules: 

i. W425 Recommend not using within a Stage, specifically an array indexed OUT coil (6070, 

thanks to MW). 

aa. New Online Project – when Offline Project is opened and user hits New Online Project, offer 

option to Connect to PLC with the currently opened Offline Project (6515). 

bb. Select PLC Connection – when showing New PLCs, the ones found via Ethernet provide the 

PLC’s Ethernet (MAC) Address in the Other column when it is different than the PLC’s Serial 

Number.  This occurs when connecting via an ECOM module instead of a built-in Ethernet port. 

cc. Select PLC Connection – supports PC Ethernet Network Adapters that are configured with 

multiple IP Addresses/Subnets (thanks to JB). 



 Do-more Updates Rel 2.8.3, February 1, 2021 

 Page 45 of 50 

dd. Select PLC Connection – when connecting to a New PLC that does not have an 

IP Configuration (out-of-box IP Address is 255.255.255.255), the Configure New IP Settings 

dialog provides an option to have the PLC use DHCP to obtain an IP Address (vs. assigning a 

static IP Address). 

ee. New System Status Nicknames 

ST38 $DumpToSecAdaptr 

 

 

 

 

0 

1 

In BRX with BX-ECOMEX POM, when 

ST36 is ON ($EnableMsgDump), use this 

bit to select which Ethernet Port to 

broadcast the messages out of: 

Primary Port (IntEthernet) 

Secondary Port (ECOMEX POM) 

DST61 $SysMsgLevel 

 ERR/MSG strings Report Level value: 

0 – do not update ERR nor MSG 

1 – update ERR only (default) 

2 – update ERR and MSG 

DST62 $Eth2IpAddress  IP Config status registers for ECOMEX 

DST63 $Eth2Netmask   

DST64 $Eth2Gateway   

DST65 $Eth2DroppedPkts  Diagnostic registers for ECOMEX 

DST66 $Eth2PktsReceivd   

DST67 $Eth2PktsSent   

DST68 $TLSTimeSlice 
 Time in MICROseconds allotted to a PLC 

scan for servicing TLS secure handshaking 

DST69 $EIPAdaptrStatus 

 When a bit is ON, the corresponding 

EtherNet/IP Adapter Connection Block is 

being “scanned” by a remote Scanner;  

Bits 0-7 correspond to EtherNet/IP 

Server/Adapter Block #1 thru #8 

DST70 $Eth2MACAddress  Last 4 bytes of ECOMEX MAC address 

ff. Launch Pad – added Open Dump File Folder to the Applications group (6488). 

gg. Output Window – no longer closes automatically if it is floating, it will only automatically close if 

it is docked (6231). 



 Do-more Updates Rel 2.8.3, February 1, 2021 

 Page 46 of 50 

hh. Data View – Write All Edits message box informing user of it NOT being able to write all 

simultaneously has a “don’t ask again” checkbox (6492): 

 

ii. Browse Videos – added support for Playlists (see Keyword list). 

jj. Browse PLC File System – added Help button (5639). 

kk. Debug->Launch DmLogger 

The Confirm Message Logging dialog 

supports the 2 new System BIT/DWORDs 

ST38 ($DumpToSecAdaptr) - let you 

choose which BRX Ethernet Port to 

dump the system generated debug/error 

messages (Primary-OFF vs. Secondary-

ON, 6585) 

DST61 ($SysMsgLevel) ERR/MSG strings 

Report Level value (6461): 

0 – do not update ERR nor MSG 

1 – update ERR only (default) 

2 – update ERR and MSG (useful for 

MQTT transaction analysis, however it also 

causes HEAVY CPU LOAD, so caveat 

emptor and remember to change it back to 

1 or 0.  

ll. Status Bar – added a new panel when connected online to a PLC, that shows status of DST61 

($SysMsgLevel) and ST36 ($EnableMsgDump) when either is NOT their default (defaults are 

ERR only, Message Dump OFF) (6508). 

  

mm. DMLoader – lets you select the specific Network Interface Card (NIC) when connecting 

to your PLC 

nn. Cross Reference – added support for Print Ranges (6581)  
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15. Adjusted Anomalies 

a. Ladder View – High Speed I/O instructions editors’ Configure HSIO Resource buttons go to the 

proper module specific resource configuration dialog (5889, 5965, 5999, 6439). 

b. Ladder View – SR Shift Register Editor’s Shift Register range description text field changed 

from 1 line to 2 lines (6458). 

c. Ladder View – RAMPSOAK instruction’s Monitor Values in Data View contains the Ramp Soak 

structure once (6441) 

d. Ladder View – after Search/Replace, refresh Stage numbers in the Address margin (6518). 

e. Ladder View – STREAMOUT’s Flush INPUT Buffer checkbox enabled properly (6534). 

f. Ladder View – MRX – Modbus Network Read instruction display no longer clips the Function 

Code parameter (6473). 

g. Ladder View – New Instruction Toolbox one-time notification dialog no longer shows up off-

screen, which was causing Designer appear to be locked up (6552, thanks to BC). 

h. Ladder View – properly handle new heap-item name (instead of a new nickname) in RUN 

instruction vs. a new nickname. 

i. Ladder View – display coils properly when part of rung with W-I-D-E boxes (6562; thanks JW). 

j. Ladder View – EIPMSG – Send EtherNet/IP Message editor’s On Success label no longer grays 

out inappropriately. 

k. Ladder View – RX/WX – Do-more Network Read/Write properly shows the Element Picker 

button for On Success and On Error JMP to Stage option. 

l. Ladder View – Replace dialog maintains proper Documentation behavior radio button as you 

add multiple replace items to the replace list (6353, thanks to JW). 

m. Ladder View – Properly handles print pagination of tall box instructions like TDOPLS with 50+ 

steps (6256). 

n. Ladder View – Replace properly handles “temporary string” parameter of SS0 utilized in newer 

instructions (6570). 

o. Ladder View – JSONBUILD properly handles switching to Array Record Type after 

“Insert Structure Fields” was performed.  Also disables the “Insert Structure Fields” button when 

Record Type is Array (6580). 

p. Ladder View – Table-based instructions properly display columns when “Lengthy Instructions” 

Ladder Option is set to “Display Short Summary” (6590). 

q. Ladder View – FILELOG handles ranged casts (6595). 

r. Ladder View – When performing Past of Rungs or Code Block, show a Status dialog (6450, 

thanks to JW). 

s. Ladder View – Drum instruction editor properly handles changing focus from the Mask or Step 

Preset field to the Output, Time, or Event fields (6451, thanks to CA). 

t. Ladder View – User Data Type parameter limits its status width (2.8.3, 6623, thanks to GD). 
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u. Ladder View – COPY, CALL support copying Heap item to Heap item (2.8.3, 6622, thanks to 

M@F) 

v. Ladder View – PWMOUT: Edit Device instruction tool works properly (2.8.3, 6613); parameters 

properly change when PWM configuration is modified or deleted (2.8.3, 6614). 

w. Ladder View – String Script Editor properly handles unsupported Element types (2.8.3, 6618, 

thanks to RBP). 

x. Ladder View – Print properly handles rungs with many rows (2.8.3, 6617, thanks to CW). 

y. System Configuration – BX-HSIO module configuration dialog properly saves entered module 

configuration name (2.8.3). 

z. System Configuration – Properly hide/disable EtherNet/IP Implicit Adapter fields and MQTT/FTP 

device creation for CPUs that do not support those features (2.8.3, 6610). 

aa. System Configuration – maintain devices associated with modules that are being disconnected 

when you change the CPU type. 

bb. System Configuration – BRX Analog Output dialog properly handles scaled values in Electrical 

mode (thanks to DS). 

cc. System Configuration – properly disables the Enable Ethernet I/O Master checkbox when PLC 

is a non-Ethernet CPU. 

dd. System Configuration – properly disables EtherNet/IP Server Block when unchecked. 

ee. Update Operating System dialog –Version Details button properly goes to Help topic about 

Do-more Technology Version 2.8 (2.8.3, 6611). 

ff. Memory View – Support Bit data blocks in addition to Numeric and Structure data blocks (2.8.3, 

6612) 

gg. Data View – Bit Display Settings for the individual graphics of a bit’s ON/OFF states warns if 

BOTH are set to the “blank” graphic (6485). 

hh. Trend View – changed ambiguous menu “Options” terminology to differentiate between the 

general View Options and the view’s specific Configuration. 

ii. Trend View – F1 Help button works in the Trend View Configuration dialog (6600). 

jj. Trend View – changes to default History Size option propagates properly (6567, thanks to GD). 

kk. Create Nickname – sets initial elements to be unused and w/o Nicknames (6549). 

ll. Download Project to PLC dialog – word wrap in Project Notes edit field behaves properly 

(6605). 

mm. Program Compare – no longer displays the Edge and Instruction IDs as part of the 

mnemonic when that option is turned off (6583, thanks to SM). 

nn. I/O System View – properly displays Analog Output Scale details (6542). 

oo. I/O System View – properly show warning state of analog modules 

pp. I/O System View – properly link to online documentation and spec sheets based on part number 

(6603). 
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qq. I/O System View – properly handles changes to the I/O Configuration when online (6607). 

rr. New Offline Project dialog’s New Project Name/Browse buttons work properly (6555, thanks to 

FD). 

ss. New Project – When creating a new Online or Offline project, use Window’s %temp% folder 

when the specified Projects folder does not exist (6556). 

tt. Open Project Files – properly report when attempting to open a “newer” versioned .dmd project 

file with an older version of Designer (6530). 

uu. PLC Communication – enhanced Windows responsiveness during PLC read/write project 

operations (5772). 
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For details about updates for version 2.7 to 2.0, see this online document: 

http://forum.hosteng.com/wndm/Updates_2_7.pdf 

 

For details about updates for version 1.4 and earlier, see this online document: 

http://forum.hosteng.com/wndm/Updates_1_4.pdf 


